
AUTHOR GUIDE 

 

JOURNAL OF SCIENTIFIC REPORTS-A, 

JOURNAL WRITING PRINCIPLES 

1. APPLICATION FORMS 

The submitted works should consist of four separate files: "Cover Page", "Article Text", "Application Checklist Form" and 

"Copyright Transfer Form". "Article Text" should be prepared according to the "Article Writing Guide" detailed below. These 

files must be uploaded to the system while uploading the article in the journalipark article upload system. 

Cover Page: The title of the work should be written in Times New Roman 10-point font in capital letters in bold font, centered 

on the page, and the title should be appropriate to the text, short and clear. Under the title, the name, surname, mail, e-mail 

and ORCID of the author/authors of the work should be written. The corresponding author should also be indicated as footnote 

information with "*" after the surname. You can download the sample "Cover Page" from the "Articles" tab on 

http://fbed.dpu.edu.tr. Author information will only be seen by the journal editor during all evaluations. 

Article Text: Manuscripts should be prepared by taking into account the details given in the "Article Writing Guide" section. 

No information about the authors should be included in the manuscript. In addition, references that identify the authors of the 

study may be kept confidential during the referee evaluation phase. 

Application Checklist Form: It is the form indicating that the text section of the work is accepted in accordance with the 

journal's spelling rules. The form should be downloaded from the "Manuscripts" tab on http://fbed.dpu.edu.tr and the spelling 

principles required in the journal format should be checked and marked. Submissions that do not comply with the journal 

format or whose checklist is not filled in will not be able to pass to the referee evaluation stage. 

Copyright Transfer Form: The copyright transfer of the articles must be downloaded from the "Articles" tab on 

http://fbed.dpu.edu.tr and signed by all authors. The signed Copyright Transfer Form must be uploaded to the system at the 

article submission stage. Submissions that have not submitted the Copyright Transfer Form will not be able to proceed to the 

referee evaluation stage. 

2. ARTICLE TEXT 

The text of the article should be prepared according to the template specified at https://dergipark.org.tr/en/pub/jsr-a/writing-rules. 

The following rules should be followed while writing the article. 

 

Click here, type the title of your paper, Capitalize first letter 

First Authora, Second Authorb, Third Authora,b,1 

aFirst affiliation, Address, City and Postcode, Country 
bSecond affiliation, Address, City and Postcode, Country  

 
* Corresponding author. Tel.: +0-000-000-0000 ; fax: +0-000-000-0000 . 

E-mail address: author@institute.xxx  

http://dx.doi.org/xxxxx 

. 



Abstract 

Click here and insert your abstract text. 

© 2023 DPU All rights reserved. 
Keywords: Type your keywords here, separated by semicolons ;  

Main text  

Here introduce the paper, and put a nomenclature if necessary, in a box with the same font size as the rest of the paper. The 

paragraphs continue from here and are only separated by headings, subheadings, images and formulae. The section headings 

are arranged by numbers, bold and 10 pt. Here follows further instructions for authors. 

 

Nomenclature 

A radius of  

B  position of 

C further nomenclature continues down the page inside the text box 

 

Structure 

Files must be in MS Word only and should be formatted for direct printing, using the CRC MS Word provided. Figures 

and tables should be embedded and not supplied separately.  

Please make sure that you use as much as possible normal fonts in your documents. Special fonts, such as fonts used in the 

Far East (Japanese, Chinese, Korean, etc.) may cause problems during processing. To avoid unnecessary errors you are 

strongly advised to use the ‘spellchecker’ function of MS Word. Follow this order when typing manuscripts: Title, Authors, 

Affiliations, Abstract, Keywords, Main text (including figures and tables), Acknowledgements, References, Appendix. Collate 

acknowledgements in a separate section at the end of the article and do not include them on the title page, as a footnote to the 

title or otherwise. 

Bulleted lists may be included and should look like this: 

First point 

Second point 

And so on 

Ensure that you return to the ‘Els-body-text’ style, the style that you will mainly be using for large blocks of text, when you 

have completed your bulleted list.  

Please do not alter the formatting and style layouts which have been set up in this template document. As indicated in the 

template, papers should be prepared in single column format suitable for direct printing onto paper with trim size 192 x 262 

mm. Do not number e front, as page numbers will be added separately for the preprints and the Proceedings. Leave a line clear 

between paragraphs. All the required style templates are provided in the file “MS Word Template” with the appropriate name 

supplied, e.g. choose 1. Els1st-order-head for your first order heading text, els-abstract-text for the abstract text etc. 

Tables 

All tables should be numbered with Arabic numerals. Every table should have a caption. Headings should be placed above 

tables, left justified. Only horizontal lines should be used within a table, to distinguish the column headings from the body of 

the table, and immediately above and below the table. Tables must be embedded into the text and not supplied separately. 

Below is an example which the authors may find useful. 

     Table 1. An example of a table. 

An example of a column heading Column A (t) Column B (t) 

And an entry 1 2 

And another entry 3 4 



And another entry 5 6 

Construction of references 

References must be listed at the end of the paper. Do not begin them on a new page unless this is absolutely necessary. 

Authors should ensure that every reference in the text appears in the list of references and vice versa. Indicate references by 

[1] or [2,3] in the text.  

Some examples of how your references should be listed are given at the end of this template in the ‘References’ section, 

which will allow you to assemble your reference list according to the correct format and font size. 

Section headings 

Section headings should be left justified, bold, with the first letter capitalized and numbered consecutively, starting with 

the Introduction. Sub-section headings should be in capital and lower-case italic letters, numbered 1.1, 1.2, etc, and left 

justified, with second and subsequent lines indented. All headings should have a minimum of two text lines after them before 

a page or column break. Ensure the text area is not blank except for the last page. 

General guidelines for the preparation of your text 

Avoid hyphenation at the end of a line. Symbols denoting vectors and matrices should be indicated in bold type. Scalar 

variable names should normally be expressed using italics. Weights and measures should be expressed in SI units. All non-

standard abbreviations or symbols must be defined when first mentioned, or a glossary provided. 

File naming and delivery 

Please title your files in this order ‘cvic acronym_conference acronym_authorslastname’. Submit both the source file and 

the PDF to the Guest Editor. 

Artwork filenames should comply with the syntax “aabbbbbb.ccc”, where: 

• a = artwork component type 

• b = manuscript reference code 

• c = standard file extension 

Component types: 

• gr = figure 

• pl = plate 

• sc = scheme 

• fx = fixed graphic 

Footnotes 

Footnotes should be avoided if possible. Necessary footnotes should be denoted in the text by consecutive superscript 

letters1. The footnotes should be typed single spaced, and in smaller type size (8 pt), at the foot of the page in which they are 

mentioned, and separated from the main text by a one line space extending at the foot of the column. The Els-footnote style is 

available in the MS Word for the text of the footnote. 

Please do not change the margins of the template as this can result in the footnote falling outside printing range. 

Illustrations 

All figures should be numbered with Arabic numerals (1, 2, 3,….). Every figure should have a caption. All photographs, 

schemas, graphs and diagrams are to be referred to as figures. Line drawings should be good quality scans or true electronic 

output. Low-quality scans are not acceptable. Figures must be embedded into the text and not supplied separately. In MS word 

input the figures must be properly coded. Preferred format of figures are PNG, JPEG, GIF etc. Lettering and symbols should 

be clearly defined either in the caption or in a legend provided as part of the figure. Figures should be placed at the top or 

 
1 Footnote text. 



bottom of a page wherever possible, as close as possible to the first reference to them in the paper. Please ensure that all the 

figures are of 300 DPI resolutions as this will facilitate good output. 

The figure number and caption should be typed below the illustration in 8 pt and left justified [Note: one-line captions of 

length less than column width (or full typesetting width or oblong) centered]. For more guidelines and information to help you 

submit high quality artwork please visit: https://dergipark.org.tr/en/pub/jsrc/writing-rules Artwork has no text along the side 

of it in the main body of the text. However, if two images fit next to each other, these may be placed next to each other to save 

space. For example, see Fig. 1.  

 

 

Fig. 1. (a) first picture; (b) second picture. 

Equations 

Equations and formulae should be typed in Mathtype, and numbered consecutively with Arabic numerals in parentheses on 

the right hand side of the page (if referred to explicitly in the text). They should also be separated from the surrounding text 

by one space. 
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4. Online license transfer 

All authors are required to complete the Cviu exclusive license transfer agreement before the article can be published, which they can 

do online. This transfer agreement enables DPU to protect the copyrighted material for the authors, but does not relinquish the 

authors’ proprietary rights. The copyright transfer covers the exclusive rights to reproduce and distribute the article, including 

reprints, photographic reproductions, microfilm or any other reproductions of similar nature and translations. Authors are 

responsible for obtaining from the copyright holder, the permission to reproduce any figures for which copyright exists. 

 

Acknowledgements 

Acknowledgements and Reference heading should be left justified, bold, with the first letter capitalized but have no 

numbers. Text below continues as normal. 

 

An example appendix 

Authors including an appendix section should do so before References section. Multiple appendices should all have 

headings in the style used above. They will automatically be ordered A, B, C etc. 

 

Example of a sub-heading within an appendix 

There is also the option to include a subheading within the Appendix if you wish. 



References 

JSR-A Reference Style Guide 

 

The below examples are taken from the JSR-C Reference Guide, which features further examples for other types of resources. JSR-

C also publishes style manuals related to grammar, rendering mathematical equations, and other elements of formatting on 

its website. 

Overview 

JSR-C is a numbered referencing style, where citations are provided as a bracketed number in the text (i.e. “as demonstrated 

in [1]”), which corresponds to a numbered reference list at the end of the document. The reference list is therefore arranged in 

the order that works are cited in the text, not in alphabetical order. Only one reference is given per reference number. Repeated 

references to a publication carry the same reference number; a resource is only listed once in the reference list. 

In the text, citations should be given simply as "in [1] ...," rather than as "in reference [1] ..." It is not necessary to mention 

either author names or publication dates in the text unless they are specifically relevant to the discussion. If you wish to refer 

to a resource with three or more authors in text, use the first author’s name, and then et al. in italics. If a specific page or figure 

needs to be highlighted, this can be done in-text, i.e., [5, pp. 4-6], or [10, Fig. 1]. 

The reference list should only include the references, with no commentary or introductory phrases such as “For example, see.” 

If necessary, such commentary should be included in the text or in a footnote on the same page as the citation. 

Example 

Text: 

As demonstrated in [1]… Other studies [2], [3] have found…   

References: 

[1] M. M. Chiampi and L. L. Zilberti, “Induction of electric field in human bodies moving near MRI: An efficient BEM 

computational procedure,” JSR-C Trans. Biomed. Eng., vol. 58, no. 10, pp. 2787–2793, Oct. 2011, doi: 

10.1109/TBME.2011.2158315. 

[2] G. Veruggio, “The EURON roboethics roadmap,” in Proc. Humanoids ’06: 6th JSR-C-RAS Int. Conf. Humanoid Robots, 

2006, pp. 612–617, doi: 10.1109/ICHR.2006.321337. 

[3] B. Klaus and P. Horn, Robot Vision. Cambridge, MA, USA: MIT Press, 1986 

  

General rules 

Author names 

Where there are more than six authors of a publication, include only the first author’s name followed by “et al.” 

Abbreviations 

JSR-C style requires abbreviation of publisher names, journal titles, and some other elements of references (see examples 

below).  

 

Books 

Format 

J. K. Author, “Title of chapter in the book,” in Title of His Published Book, xth ed. City of Publisher, (only U.S. State), 

Country: Abbrev. of Publisher, year, ch. x, sec. x, pp. xxx–xxx. 

Example 

B. Klaus and P. Horn, Robot Vision. Cambridge, MA, USA: MIT Press, 1986. 

Chapter in edited book 

R. L. Myer, “Parametric oscillators and nonlinear materials,” in Nonlinear Optics, vol. 4, P. G. Harper and B. S. Wherret, Eds. 

San Francisco, CA, USA: Academic, 1977, pp. 47–160. 

eBook 

G. O. Young, “Synthetic structure of industrial plastics,” in Plastics, vol. 3, Polymers of Hexadromicon, J. Peters, Ed., 2nd ed. 

New York, NY, USA: McGraw-Hill, 1964, pp. 15–64. [Online]. Available: http://www.bookref.com. 

  

https://ieeeauthorcenter.ieee.org/wp-content/uploads/IEEE-Reference-Guide.pdf
https://journals.ieeeauthorcenter.ieee.org/your-role-in-article-production/ieee-editorial-style-manual/


Journals 

Format 

J. K. Author, “Name of paper,” Abbrev. Title of Periodical, vol. x, no. x, pp. xxx-xxx, Abbrev. Month, year, doi: xxx. 

Example 

M. M. Chiampi and L. L. Zilberti, “Induction of electric field in human bodies moving near MRI: An efficient BEM 

computational procedure,” JSR-C Trans. Biomed. Eng., vol. 58, no. 10, pp. 2787–2793, Oct. 2011, doi: 

10.1109/TBME.2011.2158315. 

For print journals, end reference after year. 

Online (no DOI) 

Provide permalink or homepage URL of journal. 

W. P. Risk, G. S. Kino, and H. J. Shaw, “Fiber-optic frequency shifter using a surface acoustic wave incident at an oblique 

angle,” Opt. Lett., vol. 11, no. 2, pp. 115–117, Feb. 1986. [Online]. Available: http://ol.osa.org/abstract.cfm?URI=ol-11-2-115 

Published online ahead of print 

P. Kopyt et al., “Electric properties of graphene-based conductive layers from DC up to terahertz range,” JSR-C THz Sci. 

Technol., to be published. doi: 10.1109/TTHZ.2016.2544142. 

  

Articles from conference proceedings (published) 

Format 

J. K. Author, “Title of paper,” in Abbreviated Name of Conf., (location of conference is optional—City, State, Country), year, 

pp. xxx– xxx, doi: xxx. 

For print versions, end reference after page numbers. 

Example 

G. Veruggio, “The EURON roboethics roadmap,” in Proc. Humanoids ’06: 6th JSR-C-RAS Int. Conf. Humanoid Robots, 

2006, pp. 612–617, doi: 10.1109/ICHR.2006.321337. 

Online (no DOI) 

T. Schubert, “Real challenges and solutions for validating system-on-chip high level formal verification of nextgeneration 

microprocessors,” in Proc. 40th Design Automation Conf. (DAC’03), Jun. 2–6, 2003. [Online]. Available: 

http://www.computer.org/csdl/proceedings/dac/2003/2394/00/2394001-abs.html 

Proceedings with editor 

A. Amador-Perez and R. A. Rodriguez-Solis, “Analysis of a CPW-fed annular slot ring antenna using DOE,” in Proc. JSR-C 

Antennas Propag. Soc. Int. Symp., A. Amador-Perez and R. A. Rodriguez-Solis, Eds. Jul. 2006, pp. 4301–4304. 

  

Conference paper online (unpublished) 

Format 

J. K. Author. (Date). Title. Presented at Abbreviated Conf. title. [Type of Medium]. Available: site/path/file 

Example 

J. A. Taylor. (Nov. 2006). Assessment: A tool for development and engagement in the first year of university study. Presented 

at Engaging Students: 9th Pacific Rim in Higher Education (FYHE) Conf., Griffith, Australia. [Online]. Available: 

http://www.fyhe.com.au/past_papers/2006/Papers/Taylor.pdf 

  

Standards and patents 

Format 

Title of Standard, Standard number, date. [Online]. Available: http://www.url.com 

Include online availability if applicable. 

J. K. Author, “Title of patent,” Country Patent xxx, Abbrev. Month, day, year. 

Examples 



JSR-C Criteria for Class IE Electric Systems, JSR-C Standard 308, 1969. 

J. P. Wilkinson, “Nonlinear resonant circuit devices,” U.S. Patent 3 624 125, Jul. 16, 1990. 

Reports 

Format 

J. K. Author, “Title of report,” Abbrev. Name of Co., City of Co., Abbrev. State, Country, Rep. xxx, year. 

Example 

P. Diament, S. L. Richert, and W. L. Lupatkin, “V-line surface-wave radiation and scanning,” Dept. Elect. Eng., Columbia 

Univ., New York, NY, USA, Sci. Rep. 85, Aug. 1991. 

 Website 

Format 

First Name Initial(s) Last Name. “Page Title.” Website Title. Web Address (retrieved Date Accessed). 

For websites without formal titles provide descriptive phrases instead of page or website titles. 

Example 

J. Smith. “Obama inaugurated as President.” CNN.com. 

http://www.cnn.com/POLITICS/01/21/obama_inaugurated/index.html (accessed Feb. 1, 2009). 

 Social Media 

The JSR-C style doesn’t provide clear instructions for social media posts. If you need to cite social media posts in your 

coursework, you can use the below style: 

Format 

J.K. Author [@username], Full Tweet or “Title of post,” Title of Website, Abbrev. Month Day, Year. Available: URL 

(accessed: Abbrev. Month Day, Year). 

Example 

M. H. K. Choi [@choitotheworld], Can someone fix bacon packaging this has gone on long enough, Twitter, Apr 16, 2020. 

Available: https://twitter.com/choitotheworld/status/1250444150215827458 (accessed: Aug 5, 2020). 

  

https://twitter.com/choitotheworld/status/1250444150215827458


 

Instructions to Authors for Word template 

1. Locking of Copyright: 

The copyright line is locked in the Cviu templates. The author may not edit the same and making it editable only PSMs. If 

there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable 

the below mentioned steps must be followed: 

 

Steps: 

➢ Click on copyright statement 

➢ Click on Properties in Developer tab 

➢ Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then 

Press ok 

2. Docm format: 

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc 

and docx format we created the templates of all Cviu titles in .docm format. 

 

➢ Removal of all highlights 

➢ Accept track change 

➢ Locking of Rules 

 

If .docm format needs to convert in docx format then the following steps must be performed: 

 

Steps: 

➢ Press Alt  F11 

➢ Click on Project (JID_Template) 

➢ Enter "APTARA" in Project Password 

➢ Click on Microsoft Word Objects 

➢ Click on ThisDocument under Microsoft Word Objects 

➢ Delete all macros under General 

➢ After deletion close the Code and Project (JID_Template) windows 

➢ From File menu click on save as type .docx option  

3. Comments added in the margin in Word master templates: 

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, 

“Conference title per issue” and “Copyright entity, year, copyright company DPU and Organizer Name” in the copyright 

statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the 

information to be inserted by them in these fields.  

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the 

authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template 

before printing by changing the Print markup setting of word using the following steps: 

Steps: 

➢ Click the File tab 

➢ Click Print 

➢ Under Settings, click the arrow next to Print All Pages 

➢ Click Print Markup to clear the check mark  

Instructions to Authors pages to be excluded from Print:  

➢ Click the File tab 

➢ Click Print 

➢ Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document 

or the section. For example, type 1, 3, 1-5  



4. PDF creation from Word master template:  

While creating PDF from Word template the below given steps should be followed to avoid difference in trim size and 

margins and to avoid decrease in resolution and size of the figure images of the Word template and the PDF created. 

 

Steps in Word 2007 and 2010: 

➢ Click the File tab 

➢ Click Print 

➢ Under Printer tab, select Adobe PDF  

➢ Click Printer Properties link 

➢ Under Adobe PDF Settings tab, click on Edit button 

➢ Click on Images folder under Standard 

➢ Make Downsample and Compression fields under Color Images and Grayscale Images "Off". And in Monochrome 

Images field make only Downsample "Off' 

➢ Then click on OK and given name of the setting in File name tab and click on save 

➢ Then again Under Adobe PDF Settings tab, click on Edit button 

➢ Then click on Color folder  

➢ Choose Leave Color Unchanged option under Color Management Policies tab then click on OK 

➢ Lastly click on OK in Adobe PDF Settings tab 

➢ Click Save As 

➢ Under Save as type, click the arrow next to PDF (*.pdf) 

➢ Click Save 

 

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can 

be adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above steps to avoid 

decrease in resolution and size of the figure images. 

 


